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2. About this document 
 
This is the users manual on how to get started with DewesoftX® and SIRIUS®. 
 

2.1. Legend 
 
The following symbols and formats will be used throughout the document. 
 

 
Important 
It gives you important information about the subject. 
Please read carefully! 

 
Hint 
It gives you a hint or provides additional information about a subject. 
 

 
Example 
Gives you an example of a specific subject. 
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3. Installation 
 

3.1. Download 
The Dewesoft​X​® installer can be found on the provided USB stick or on our download  ​webpage​. 

To start the DewesoftX® installer, double click on the full installer executable file. 

 

3.2. Compatibility 
 DewesoftX®​ supports the operating system Windows, Version 7 (32-bit and 64-bit) and newer. 
 

3.3. Licensing 
● The license for measuring with ​ DewesoftX®​is included in the device (usually PROF version). 

Once it is connected on the USB port, it acts as a dongle. 
● The license for analysing is free! ​ DewesoftX®​can be installed on any computer and the stored 

data files can be opened, recalculated, and exported. 
● Additional licenses can be required for plugins, these can then also be written into the 

Dewesoft® device. To test plugins, you can request a 30-days-Evaluation license. 

3.3.1. Requesting an Evaluation license 
You can request an an Evaluation license from our homepage: 
https://dewesoft.com/support/software-registration 
 
To receive a fully functional 30-day evaluation license for DewesoftX​®​ software fill and submit the form 
below (Evaluation license tab). Data marked with * are required. Please provide a valid email address to 
which we can send the evaluation license. 

 
 Image 1: Request an evaluation license 
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3.3.2. Activating the Evaluation license 
When you have received your trial licence key, open DewesoftX®, go to Options → Settings → Licensing 
 
Then select “Create new license”, enter your license key and press the arrow next to the license number 
button. 
 

 
 Image 2: Activating the license 

 
Then your new license key will show up in the list of Active licenses and should have the status TRIAL. 
 

3.4. Plug-in Installation 
Depending on which plugin or extension you want to use, please follow the installation procedure 
described in the according manual. 
 
The plugin(s) can be found under Options → Settings → Extensions. If the list is empty, you have to 
register the plugins first. This can be done according to the hint below. 

 
 Image 3: Adding the plugins 
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Hint 

When you are using Windows®, then you must click the Register plugins button (the button 

with the two curved arrows) once and restart DewesoftX® before the plugin shows up in the 

list of Extensions. This usually requires admin rights. 

 

4. Equipment 
 
This document is meant for users, who are using the software and/or SIRIUS® for the first time and want 

a quick guide to start effective working. One sensor after the other will be connected and a basic 

measurement will be done. It makes sense to work this through from the start to the end, as with each 

measurement more details and different instruments / functions are shown.  

 
 Image 4: Demo equipment used in this document 

 
The demokit consists of the SIRIUS® device, with its installation USB stick and the three sensors:  

● Acceleration sensor  
● Tuning fork  
● Encoder 
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5. Connecting the SIRIUS® 
 

5.1. The Launcher 
 
After the DewesoftX® installation, there is a small program in the taskbar of Windows, the Launcher. 

 
 Image 5: DewesoftX® launcher 

 
When you connect the USB cable to your Dewesoft hardware (e.g. SIRIUS®), the launcher will 
automatically pop-up a window and check the Power- & Sync- status. This is especially helpful if multiple 
single SIRIUS® devices (“slices”) are connected.  
 

 
 Image 6: DewesoftX® launcher will auto-detect connected Dewesoft Hardware 

 
Simply click “Run Dewesoft”. 
 

5.2. Manual setup of hardware  
 
In case you need to manually set up the hardware, please start DewesoftX® and go to Options → 
Settings. Under Devices, set the operation mode to “Real measurement”.  
 

 
 Image 7: DewesoftX® settings operation mode 
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Then scan for the hardware with the refresh button. The SIRIUS® will be found with the according serial 
number. 

 

 
 Image 8: DewesoftX® settings structure 

 
When you leave the Settings menu with pressing the ‘’OK’’ button, then you should get the “Channel 
Setup” screen, showing the instrument with the built-in amplifiers. 

 

 
 Image 9: Ready to start 
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Notice, the two buttons on the left upper corner – Acquisition and Analysis. One mode is for storing the 
data, the other is for reloading data files and analysing them. 
 
You should be now in Acquisition mode, on the Channel setup tab. 
 

 
 Image 10: Acquisition and Analysis mode 

 
Now the sensors can be connected.  
 

6. Acceleration sensor 
 
We connect an IEPE accelerometer on the first channel. 

 
 Image 11: Connected acceleration sensor to the Dewesoft SIRIUS® device 

 
1. First, think about the required sampling rate. What is the highest input frequency we expect? In 

the dropdown “Dynamic acquisition rate” the default value is usually 20 kS/s, which is fine for 
now. 

2. If not already set, activate the channel by setting it to “Used”. 
3. As the SIRIUS-ACC amplifier supports two input modes, in the row of the first amplifier please set 

the “Measurement” from Voltage to “IEPE”, so the amplifier will supply the sensor. If the “Ampl. 
name” (and the LED ring on the instrument around the BNC connector) gets green after a few 
seconds, we know that the sensor impedance is OK. 

4. Then enter the Channel setup window by pressing the “Setup” button. 
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 Image 12: Channel setup 

 

6.1. Channel setup 
 
The Channel setup window splits up into left (Amplifier settings) and right (Sensor settings) side. 
Furthermore you can change the name: 

● Amplifier settings​ - With the “Dual core” option set (if you own a Dual-core SIRIUS®), we don't 
have to care about the input range. On the bottom you see a quick preview of the sensor signal, 
knock on the accelerometer for testing. 

● Sensor settings ​-​ ​In our case the accelerometer has built-in TEDS (transducer electronic data 
sheet), so automatically all the calibration factor and calibration data (by the way: out of date, see 
red warning) is read from it.  
In any other case - Enter the Physical quantity (Acceleration) and the Unit (either g or m/s²) and 
the calibration factor below, or put the sensor on a reference shaker and press the Calibrate 
button. 

 
 Image 13: Channel setup window 
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6.2. Storing 
 
Before starting the measurement, please go to the Storing ribbon, and specify a file name. The Storing 
type is set to always fast, here you can specify trigger conditions later. 
 
Then click the Store button to start storing the measurement.  

 
 Image 14: In Storing tab set the file name and start storing 

 

6.3. Recorder 
 
DewesoftX® switches to Measure mode. For faster navigation on top, there are 2 screens - Recorder, and 
Custom... predefined. The screens contain instruments, and can be freely defined. The Recorder screen 
currently consists of one Recorder instrument. 
 
Do a few hits on the accelerometer. 
 

 
 Image 15: Display preview in measurement mode 
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The recorder y axis automatically adapts to the currently visible minimum/maximum values. In the 
Recorder properties on the left “Auto scale” is enabled. 
 
On the right side is the channel list, showing the channel currently assigned to the Recorder instrument. 
 
After you have done the measurement, please click Stop, then change to Analysis mode. 
 

6.4. Analysis 
 
Let's take a look at the recorded data. You are now in "Analysis mode". The last recorded data file is 
automatically reloaded. Let's zoom into one of the peaks. 
 
To zoom in, press the left mouse button, hold it down while moving to the right, then release. If you 
move the mouse between the two cursors, there is a small + attached to the mouse icon, and if you click 
between cursors, the area will be zoomed in. 
 
To zoom out to the previous level again, simply click the right mouse button. 
 

 
 Image 16: Zoom in Analysis 
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You can zoom in until you see the sampling points (20 kHz). 
 

 
 Image 17: Zoom sample points 

 

6.5. Export 
 
Only the selected region (in the overview instrument on top) will be exported! 
 

 
 Image 18: Overview instrument 
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Go to the Export section (1) -> File Export (2), choose the file type and properties, enable or disable 
channels from the right, then click the Export (3) button. 
 

 
 Image 19: Export section 

 
The FlexPro and MSExcel Active X ribbons on top will export into a template, which you can adapt, in 
order to directly export in your finished report. 
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7. Strain gage 
 
We connect a strain gage on one of the STG inputs of our SIRIUS®. 

 
 Image 20: Strain gage connected 

 

A "tuning fork" is normally used for tuning the instruments of an orchestra. It is tuned to 440Hz, which is 
the standard pitch (note 'a'). In our demo tool, a quarter bridge strain gauge with either 120 or 350 ohms 
resistance (is marked on the connector) is mounted on the steel, therefore we can measure the strain of 
the vibrations. 

 
 Image 21: Strain gage data 

 
Open the Setup of the channel where the tuning fork is connected to. 
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 Image 22: Strain gage channel setup 

 

In the left upper section, we find the amplifier settings. Set to "Bridge" and "Quarter bridge 3-wire", 
either 120 or 350 ohm (written on connector). You directly see the according circuitry, how to connect 
the quarter bridge on the 9pin DSUB connector. 
 
Select an appropriate range, if you use the highest, you don't have to care about overload (input voltage 
exceeding amplifier range). We use a smaller range, e.g. 20mV/V. The higher ADC is now working in the 
20mV/V input range, while the lower ADC input range is 5% of it, 1 mV/V simultaneously, so you get an 
amazing dynamic. 
 
On the right side - Sensor settings, we select Physical quantity Strain or Stress and the unit. If you have a 
sensor with a TEDS chip, and all the settings are read from it automatically. 
 

7.1. Balance sensor 
 
Before starting the measurement, we need to balance the strain gage. Click “Balance”, the output will 
go to 0 um/m, and the offset will be shown next to the button.  
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 Image 23: Balance sensor 

 

7.2. Sampling rate 
 
Because the natural frequency of the tuning fork is 440Hz, we have to think of which sample rate we 
want to digitize the signal. In theory, a factor of 2 (=880Hz, Nyquist criteria) would be sufficient, in praxis 
however it depends very much how the signal looks like. We suggest a factor of 10 or even 20 to get a 
good result. 
 
So, the sample rate is still fine with 20 kHz. 
 
Go again to "Storing", specify a filename, e.g. "tuning_fork_measurement". Then click "Store". 
 

7.3. Scope Widget 
 
Now we switch to the Custom... display and add the Scope widget to it. Maximize it over the whole 
screen. 
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 Image 24: Add a Scope widget 

 

 
 Image 25: Scope display can be randomly adjusted 

Switch to the Scope screen. Hit the tuning fork, that we have an oscillating signal, then click the y-axis 
label for min/max scaling. 
 
Set the trigger to Auto, in the properties of the left. Move the trigger level up- or downwards with the 
mouse, until you get a triggered image. 
 
With the +/- buttons on the x-axis , you can adjust the time window shown. 
 

 

7.4. Customizing Displays 
 
Now we want to add an FFT instrument, to measure the resonance frequency of the tuning fork. Usually 
the Custom... screens are always empty so you fill them with any widgets, but basically no matter what 
display is, every display can be adapted to your needs. 
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7.4.1. Design mode 
 
Enable the ''Design mode'', either by clicking the ''Design'' tab on the top or by pressing keyboard 
shortcut CTRL+D or just by starting adding the Widgets by clicking on ''Widgets'' tab. 
 

 
 Image 26: Enable Design mode 

 
 
In the Widget search window type in FFT and add an FFT widget on a display. 
 

 
 Image 27: Adding widgets to the display  

 
Automatically the channel ''AI 1'' is assigned to the instrument as it is the only ''Used'' channel we had. 
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 Image 28: Added FFT widget  

 
As you are in ''Design mode'' you can now freely adapt the size of the FFT and move it to your favorite 
location on the screen. After you fit the FFT diagram to your needs, exit the Design mode by clicking on 
a Design button.  

7.4.2. FFT instrument 
 
Following steps help to get your data displayed quickly with the FFT: 
 

● Y scale type set on ''Log''. 
● Adjust Y-axis according to the range you are measuring. In this case, it is set from 0.001 to 1000 

um/m. 
● Click on the measured peak when the tuning for is vibrating. The values of the peak will be 

displayed, showing the maximum of 439,5 Hz with the according to amplitude. 
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 Image 29: FFT widget setup 

 

7.5. Analysis folder view 
 
After stopping the measurement, click on the Analysis button, and go to the Data files tab. You will see 
the Analysis folder view, which is like an Explorer. On the bottom you get information about the 
channels and data header, and with the powerful search fields you easily find the data file you are 
looking for. 
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 Image 30: Analysis folder view 

8. Encoder 
 
Now we connect the demo encoder to e.g. ACC+ or STG+ (with additional Lemo connector), or MULTI 
module. 

 
 Image 31: Encoder connected 

 

Per default the Counter inputs are not visible in DewesoftX®, we have to add them with the “+ More” 
button. 

 
 Image 32: Add Counters 
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Also other software options can be added here, e.g. Power, Order tracking, Modal test… 
 
The Counters will appear now as a ribbon on top. 
 
The buttons on top can be customized, click the ''+'' button again, go to ''New setup defaults'' and set the 
asterisk for the Counters. From now on they will appear as default each time when starting DewesoftX®. 
 

 
 Image 33: Customizing the buttons 

 
There are two typical counter techniques:  
 

● the gated measurement (high-frequency range typical > 100 Hz), and 
● pulse width measurement (low-frequency range typical < 100 Hz). 

 
Many applications need both, the counter information and the analog data. Traditional systems do not 
offer the counter information synchronized to the A/D converters because they get the counter 
information only either after the gate time or after the pulse time measured. In comparison to standard 
counting with software interpolation (value 1.5 shown on image 24), DewesoftX® real-time counting 
uses an additional counter on a 102 MHz time base to get the exact time of the rising edge of the signal. 
This unique feature allows the calculation of the exact counter value at the A/D sample point (value 1.87 
on the image below). 
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 Image 34: How DewesoftX® counters work 

 
When you turn the encoder, you should already see the Counter value increasing. Each counter (CNT x) 
consists of 3 digital inputs (IN0, IN1 and IN2). Set the channels to Used and enter the Setup. 
 

 
 Image 35: Counter section 

 

8.1. Counter setup 

 
 Image 36: Counter setup 
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In our case, we have a 1024-pulses Encoder with A, B, and Z track. Set the basic application to Sensor 
(encoder... and the sensor type to ''Encoder-1024''. Enable the ''Encoder zero'', so the angle will be reset 
with the Z pulse once per revolution, and also enable the Automatic angle wrap around. 
 
The most important output channels below are Angle, Frequency, and Raw_Count. 
 
Go to the Design mode and add Analog meter, Digital meter, and Recorders. Set the properties on the 
left for each instrument (min, max values, and resolution). To assign/unassign a channel to an 
instrument, click on the instrument first, then select/deselect the channel from the channel list on the 
right. 
 

 
 Image 37: Example of a customized screen 

 

   

V21-1 26/33   



Getting started 
SOFTWARE USER MANUAL 

 

 

8.2. Analog and digital meter 
 
Below you see some example properties for the analog and digital meter. This should help you for 
displaying your RPM signal. 
 

 
 Image 38: Properties for Analog and Digital meter  

 

8.3. Save setup 
 
After you have done all the sensor settings and created your own screen, you can save this setup/display 
configuration to a setup file (*.dxs). Therefore stop the measurement, or go back to Channel setup, then 
click the DewesoftX® icon button, and use ''Save setup as...''. 
 

 
 Image 39: Save the setup 

 
The same way you can load any configurations.  
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9. Frequently asked questions 
 
This section should help to find quick solutions for known problems. 
 

9.1. Problem: Sine waves on all channels 
 
In case you have set the Operation mode in DewesoftX® to “Simulation” mode, you will get a picture like 
below - sine waves with random amplitude and frequency on all channels. 
 

 
 Image 40: Simulation mode signals 

 
When you switch back to Ch. Setup, the amplifiers will show “Demo-...”. In this case, please follow the 
steps described in chapter ​5.2 Manual setup of hardware​. 

 
 Image 41: Simulation mode amplifiers 
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10. Warranty information 
 
Notice 
The information contained in this document is subject to change without notice. 
 
Note: 
Dewesoft d.o.o. shall not be liable for any errors contained in this document. Dewesoft MAKES NO 
WARRANTIES OF ANY KIND WITH REGARD TO THIS DOCUMENT, WHETHER EXPRESS OR IMPLIED. 
DEWESOFT SPECIFICALLY DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. Dewesoft shall not be liable for any direct, indirect, special, 
incidental, or consequential damages, whether based on contract, tort, or any other legal theory, in 
connection with the furnishing of this document or the use of the information in this document. 
 
The copy of the specific warranty terms applicable to your Dewesoft product and replacement parts can 
be obtained from your local sales and service office. To find a local dealer for your country, please visit 
https://dewesoft.com/support/distributors​. 
 
10.1. Calibration 
Every instrument needs to be calibrated at regular intervals. The standard norm across nearly every 
industry is annual calibration. Before your Dewesoft data acquisition system is delivered, it is calibrated. 
Detailed calibration reports for your Dewesoft system can be requested. We retain them for at least one 
year, after system delivery. 
 
10.2. Support 
Dewesoft has a team of people ready to assist you if you have any questions or any technical difficulties 
regarding the system. For any support please contact your local distributor first or Dewesoft directly. 
 
Dewesoft d.o.o. 
Gabrsko 11a 
1420 Trbovlje Slovenia 
 
Europe Tel.: +386 356 25 300 
Web: ​http://www.dewesoft.com 
Email: ​Support@dewesoft.com 
The telephone hotline is available Monday to Friday from 07:00 to 16:00 CET (GMT +1:00) 
 

10.3. Service/repair 
The team of Dewesoft also performs any kinds of repairs to your system to assure a safe and proper 
operation in the future. For information regarding service and repairs please contact your local 
distributor first or Dewesoft directly on ​https://dewesoft.com/support/rma-service​. 
 

10.4. Restricted Rights 
Use Slovenian law for duplication or disclosure. Dewesoft d.o.o. Gabrsko 11a, 1420 Trbovlje, Slovenia / 
Europe. 
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10.5. Printing History 
Version 2.0.0, Revision 217 Released 2015 Last changed: 23. July 2018 at 16:54. 
 
10.6. Copyright 
Copyright © 2015-2019 Dewesoft d.o.o. This document contains information which is protected by 
copyright. All rights are reserved. Reproduction, adaptation, or translation without prior written 
permission is prohibited, except as allowed under the copyright laws. All trademarks and registered 
trademarks are acknowledged to be the property of their owners. 
 
10.7. Trademarks 
We take pride in our products and we take care that all key products and technologies are registered as 
trademarks all over the world. The Dewesoft name is a registered trademark. Product families 
(KRYPTON, SIRIUS, DSI, DS-NET) and technologies (DualCoreADC, SuperCounter, GrandView) are 
registered trademarks as well. When used as the logo or as part of any graphic material, the registered 
trademark sign is used as a part of the logo. When used in text representing the company, product or 
technology name, the ® sign is not used. The Dewesoft triangle logo is a registered trademark but the ® 
sign is not used in the visual representation of the triangle logo. 
 
 

11. Safety instructions 
Your safety is our primary concern! Please be safe! 
 
11.1. Safety symbols in the manual 

 
Warning  
Calls attention to a procedure, practice, or condition that could cause the body injury or death  
 
Caution 
Calls attention to a procedure, practice, or condition that could possibly cause damage to 
equipment or permanent loss of data.   

 
11.2. General Safety Instructions 
 

 
Warning  
 

The following general safety precautions must be observed during all phases of operation, service, and 
repair of this product. Failure to comply with these precautions or with specific warnings elsewhere in 
this manual violates safety standards of design, manufacture, and intended use of the product. 
Dewesoft GmbH assumes no liability for the customer’s failure to comply with these requirements.  
 
All accessories shown in this document are available as an option and will not be shipped as standard 
parts. 
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11.2.1. Environmental Considerations 
Information about the environmental impact of the product. 

11.2.2. Product End-of-Life Handling 
Observe the following guidelines when recycling a Dewesoft system: 

11.2.3. System and Components Recycling 
Production of these components required the extraction and use of natural resources. The substances 
contained in the system could be harmful to your health and to the environment if the system is 
improperly handled at its end of life! Please recycle this product in an appropriate way to avoid 
unnecessary pollution of the environment and to keep natural resources. 
 

This symbol indicates that this system complies with the European Union’s requirements 
according to Directive 2002/96/EC on waste electrical and electronic equipment (WEEE). 
Please find further information about recycling on the Dewesoft web site 
www.dewesoft.com 
 
Restriction of Hazardous Substances 

This product has been classified as Monitoring and Control equipment and is outside the scope of the 
2002/95/EC RoHS Directive. However, we take care of our environment and the product is lead-free. 

11.2.4. General safety and hazard warnings for all Dewesoft systems 
Safety of the operator and the unit depend on following these rules. 

● Use this system under the terms of the specifications only to avoid any possible danger. 
● Read your manual before operating the system. 
● Observe local laws when using the instrument. 
● DO NOT touch internal wiring! 
● DO NOT use higher supply voltage than specified! 
● Use only original plugs and cables for harnessing. 
● You may not connect higher voltages than rated to any connectors. 
● The power cable and connector serve as Power-Breaker. The cable must not exceed 3 meters, 

the disconnect function must be possible without tools. 
● Maintenance must be executed by qualified staff only. 
● During the use of the system, it might be possible to access other parts of a more comprehensive 

system. Please read and follow the safety instructions provided in the manuals of all other 
components regarding warning and security advice for using the system. 

● With this product, only use the power cable delivered or defined for the host country. 
● DO NOT connect or disconnect sensors, probes or test leads, as these parts are connected to a 

voltage supply unit. 
● Ground the equipment: For Safety Class 1 equipment (equipment having a protective earth 

terminal), a non-interruptible safety earth ground must be provided from the mains power 
source to the product input wiring terminals. 

● Please note the characteristics and indicators on the system to avoid fire or electric shocks. 
Before connecting the system, please read the corresponding specifications in the product 
manual carefully. 
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● The inputs must not, unless otherwise noted (CATx identification), be connected to the main 

circuit of category II, III and IV. 
● The power cord separates the system from the power supply. Do not block the power cord, since 

it has to be accessible for the users. 
● DO NOT use the system if equipment covers or shields are removed. 
● If you assume the system is damaged, get it examined by authorized personnel only. 
● Adverse environmental conditions are Moisture or high humidity Dust, flammable gases, fumes 

or dissolver Thunderstorm or thunderstorm conditions (except assembly PNA) Electrostatic 
fields, etc. 

● The measurement category can be adjusted depending on module configuration. 
● Any other use than described above may damage your system and is attended with dangers like 

short-circuiting, fire or electric shocks. 
● The whole system must not be changed, rebuilt or opened. 
● DO NOT operate damaged equipment: Whenever it is possible that the safety protection 

features built into this product have been impaired, either through physical damage, excessive 
moisture, or any other reason, REMOVE POWER and do not use the product until the safe 
operation can be verified by service-trained personnel. If necessary, return the product to 
Dewesoft sales and service office for service and repair to ensure that safety features are 
maintained. 

● If you assume a more riskless use is not provided anymore, the system has to be rendered 
inoperative and should be protected against inadvertent operation. It is assumed that a more 
riskless operation is not possible anymore if the system is damaged obviously or causes strange 
noises. The system does not work anymore. The system has been exposed to long storage in 
adverse environments. The system has been exposed to heavy shipment strain. 

● Warranty void if damages caused by disregarding this manual. For consequential damages, NO 
liability will be assumed! 

● Warranty void if damage to property or persons caused by improper use or disregarding the 
safety instructions. 

● Unauthorized changing or rebuilding the system is prohibited due to safety and permission 
reasons (CE). 

● Be careful with voltages >25 VAC or >35 VDC! These voltages are already high enough in order to 
get a perilous electric shock by touching the wiring. 

● The product heats during operation. Make sure there is adequate ventilation. Ventilation slots 
must not be covered! 

● Only fuses of the specified type and nominal current may be used. The use of patched fuses is 
prohibited. 

● Prevent using metal bare wires! Risk of short circuit and fire hazard! 
● DO NOT use the system before, during or shortly after a thunderstorm (risk of lightning and high 

energy over-voltage). An advanced range of application under certain conditions is allowed with 
therefore designed products only. For details please refer to the specifications. 

● Make sure that your hands, shoes, clothes, the floor, the system or measuring leads, integrated 
circuits and so on, are dry. 

● DO NOT use the system in rooms with flammable gases, fumes or dust or in adverse 
environmental conditions. 

● Avoid operation in the immediate vicinity of high magnetic or electromagnetic fields, 
transmitting antennas or high-frequency generators, for exact values please refer to enclosed 
specifications. 

● Use measurement leads or measurement accessories aligned with the specification of the 
system only. Fire hazard in case of overload! 
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● Do not switch on the system after transporting it from a cold into a warm room and vice versa. 

The thereby created condensation may damage your system. Acclimatise the system unpowered 
to room temperature. 

● Do not disassemble the system! There is a high risk of getting a perilous electric shock. 
Capacitors still might be charged, even if the system has been removed from the power supply. 

● The electrical installations and equipment in industrial facilities must be observed by the security 
regulations and insurance institutions. 

● The use of the measuring system in schools and other training facilities must be observed by 
skilled personnel. 

● The measuring systems are not designed for use in humans and animals. 
● Please contact a professional if you have doubts about the method of operation, safety or the 

connection of the system. 
● Please be careful with the product. Shocks, hits and dropping it from already-  lower level may 

damage your system. 
● Please also consider the detailed technical reference manual as well as the security advice of the 

connected systems. 
● This product has left the factory in safety-related flawlessness and in proper condition. In order to 

maintain this condition and guarantee safety use, the user has to consider the security advice 
and warnings in this manual. 

 
EN 61326-3-1:2008 
IEC 61326-1 applies to this part of IEC 61326 but is limited to systems and equipment for industrial 
applications intended to perform safety functions as defined in IEC 61508 with SIL 1-3. 
 
The electromagnetic environments encompassed by this product family standard are industrial, both 
indoor and outdoor, as described for industrial locations in IEC 61000-6-2 or defined in 3.7 of IEC 61326-1. 
 
Equipment and systems intended for use in other electromagnetic environments, for example, in the 
process industry or in environments with potentially explosive atmospheres, are excluded from the 
scope of this product family standard, IEC 61326-3-1. 
 
Devices and systems according to IEC 61508 or IEC 61511 which are considered as “operationally 
well-tried”, are excluded from the scope of IEC 61326-3-1. 
 
Fire-alarm and safety-alarm systems, intended for the protection of buildings, are excluded from the 
scope of IEC 61326-3-1. 

 
11.3. Documentation version history 
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